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Chapter 1 
Overview of SOLIDWORKS® 2021 and the User Interface 

Below are the desired outcomes and usage competencies based on the completion of 
Chapter 1.  

Desired Outcomes: Usage Competencies: 

• A comprehensive
understanding of the
SOLIDWORKS® 2021 User
Interface (UI) and
CommandManager.

• Ability to establish a SOLIDWORKS session.

• Aptitude to utilize the following items: Menu
bar toolbar, Menu bar menu, Drop-down
menus, Context toolbars, Consolidated drop-
down toolbars, System feedback icons,
Confirmation Corner, Heads-up View toolbar,
Document Properties, and more.

• Open a new and existing SOLIDWORKS part.

• Knowledge to zoom, rotate and maneuver a
three-button mouse in the SOLIDWORKS
Graphics window.
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Notes: 
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Chapter 1 - Overview of SOLIDWORKS® 2021 and the User Interface 

Chapter Objective 

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface 
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons, 
Confirmation Corner, Heads-up View toolbar and more.   

On the completion of this chapter, you will be able to: 

• Utilize the SOLIDWORKS Welcome dialog box.

• Establish a SOLIDWORKS session.

• Comprehend the SOLIDWORKS User Interface.

• Recognize the default Reference Planes in the FeatureManager.

• Open a new and existing SOLIDWORKS part.

• Utilize SOLIDWORKS Help and SOLIDWORKS Tutorials.

• Zoom, rotate and maneuver a three-button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®? 

• SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®

Windows graphical user interface.

• SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

• Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.

• This book is written for the beginner to intermediate user.
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Start a SOLIDWORKS Session 

Start a SOLIDWORKS session and familiarize yourself with the SOLIDWORKS User 
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of 
how to use the book and the structure. Actual input commands or required actions in the 
chapter are displayed in bold. 

The book does not cover starting a SOLIDWORKS session in detail for the first time. A 
default SOLIDWORKS installation presents you with several options. For additional 
information, visit http://www.SOLIDWORKS.com. 

Activity: Start a SOLIDWORKS Session. 

Start a SOLIDWORKS session. 

1) Type SOLIDWORKS 2021 in the Search window.

2) Click the SOLIDWORKS 2021 application (or if available,
double-click the SOLIDWORKS icon on the desktop).
The SOLIDWORKS Welcome dialog box is displayed by
default.

The Welcome dialog box provides a convenient way to 
open recent documents (Parts, Assemblies and Drawings), view 
recent folders, access SOLIDWORKS resources, and stay 
updated on SOLIDWORKS news.  

3) View your options. Do not open a document at this time.
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4) If the Welcome dialog box is not
displayed, click the Welcome to

SOLIDWORKS  icon from the
Standard toolbar or click Help >
Welcome to SOLIDWORKS from the
Main menu.

Home Tab

The Home tab lets you open new and 
existing documents, view recent 
documents and folders, and access 
SOLIDWORKS resources (Part, 
Assembly, Drawing, Advanced mode, 
Open).  

Recent Tab

The Recent tab lets you view a longer list 
of recent documents and folders. 
Sections in the Recent tab include 
Documents and Folders.  

The Documents section includes 
thumbnails of documents that you have 
opened recently.  

Click a thumbnail to open the document, 
or hover over a thumbnail to see the 
document location and access additional 
information about the document. When 
you hover over a thumbnail, the full path 
and last saved date of the document 
appears. 

Learn Tab

The Learn tab lets you access 
instructional resources to help you learn 
more about the SOLIDWORKS 
software.  

Sections in the Learn tab include: 

• Introducing SOLIDWORKS.
Open the Introducing
SOLIDWORKS book.

• Tutorials. Open the step-by-step tutorials in the SOLIDWORKS software.

• MySolidWorks Training. Open the Training section at MySolidWorks.com.
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• Introducing SOLIDWORKS (Samples). Open local folders containing sample models.

• Tutorials (Samples). Open the SOLIDWORKS Tutorials (videos) section at
solidworks.com.

• What’s New (Samples). List of new changes.

• MySOLIDWORKS - CAD Models. Open models in 3D ContentCentral and the
Community Library.

• My Training. Open the My Training section at MySolidWorks.com.

• Certification. Open the SOLIDWORKS Certification Program section at
solidworks.com.

• Curriculum. Open the Curriculum section at solidworks.com.

When you install the software, if
you do not install the Help Files or 
Example Files, the Tutorials and 
Samples links are unavailable. 

Alerts Tab

The Alerts tab keeps you updated with 
SOLIDWORKS news.  

Sections in the Alerts tab include 
Critical, Troubleshooting, and Technical. 

The Critical section does not appear 
if there are no critical alerts to display. 

• Troubleshooting. Includes
troubleshooting messages and
recovered documents that used to be
on the SOLIDWORKS Recovery
tab in the Task Pane.

If the software has a technical problem and an associated 
troubleshooting message exists, the Welcome dialog box opens 
to the Troubleshooting section automatically on startup, even if 
you selected Do not show at startup in the dialog box.  

• Technical Alerts. Open the contents of the SOLIDWORKS
Support Bulletins RSS feed at solidworks.com.
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Close the Welcome dialog box. 

5) Click Close  from the Welcome dialog box. The SOLIDWORKS
Graphics window is displayed. Note: You can also click outside the
Welcome dialog box, in the Graphics window.

View the SOLIDWORKS Graphics window. 

Menu Bar toolbar 

The SOLIDWORKS (UI) 
is designed to make 
maximum use of the 
Graphics window. The 
Menu Bar toolbar contains a 
set of the most frequently 
used tool buttons from the Standard toolbar. 

The following default tools are available: 

• Welcome to SOLIDWORKS  - Open the Welcome dialog box, New  - Create a
new document; Open  - Open an existing document; Save  - Save an active 

document; Print  - Print an active document; Undo  - Reverse the last action;

Redo  - Redoes the last action that you reverse; Select   - Select Sketch entities,

components and more; Rebuild  - Rebuild the active part, assembly or drawing;    
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File Properties  - Summary information on the active document; Options  - 
Change system options and Add-Ins for SOLIDWORKS; Login - Login to 
SOLIDWORKS; Help  - access to help, tutorials, updates and more.  

Menu Bar menu 

Click SOLIDWORKS in the Menu Bar toolbar to 
display the Menu Bar menu. SOLIDWORKS provides 
a context-sensitive menu structure. 
The menu titles remain the same for 
all three types of documents, but the 
menu items change depending on 
which type of document is active.   

Example: The Insert menu includes features in part documents, mates in assembly 
documents, and drawing views in drawing documents. The display of the menu is also 
dependent on the workflow customization that you have selected. The default menu items for 
an active document are File, Edit, View, Insert, Tools, Window, Help and Pin. 

The Pin  option displays the Menu bar toolbar and the Menu bar menu as illustrated. 
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the 
Menu bar.  

Drop-down menu

SOLIDWORKS takes advantage of the familiar Microsoft® 
Windows user interface. Communicate with SOLIDWORKS 
through drop-down menus, Context sensitive toolbars, 
Consolidated toolbars or the CommandManager tabs.  

To close a SOLIDWORKS drop-down menu, press the Esc key. 
You can also click any other part of the SOLIDWORKS 
Graphics window or click another drop-down menu.  
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Create a New Part Document 

Activity: Create a new Part Document. 

A part is a 3D model, which consists of features. What are features? Features are geometry 
building blocks. Most features either add or remove material. Some features do not affect 
material (Cosmetic Thread). 

Features are created either from 2D or 3D sketched profiles or from edges and faces of 
existing geometry.  

Features are individual shapes that combined with other features make up a part or assembly. 
Some features, such as bosses and cuts, originate as sketches. Other features, such as shells 
and fillets, modify a feature's geometry.  

Features are displayed in the FeatureManager. 

The first sketch of a part is called the Base Sketch. The Base sketch is the foundation for 
the 3D model. The book focuses on 2D sketches and 3D features.  

FeatureManager and CommandManager tabs and tree folders will vary depending on 
system setup, version, and Add-ins. 
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There are two modes in the New 
SOLIDWORKS Document dialog 
box: Novice and Advanced. The 
Novice option is the default option 
with three templates. The 
Advanced mode contains access to 
additional templates and tabs that 
you create in system options. Use 
the Advanced mode in this book.  

Create a new part.  

6) Click New  from the Menu 
bar. The New SOLIDWORKS 
Document dialog box is 
displayed.  

Select the Advanced mode. 

7) Click the Advanced button as 
illustrated. The Advanced 
mode is set.  

8) Click the Templates tab. 

9) Click Part. Part is the default 
template from the New 
SOLIDWORKS Document 
dialog box.  

10) Click OK from the New 
SOLIDWORKS Document 
dialog box.  

The Advanced mode remains 
selected for all new documents in the current SOLIDWORKS session. When you exit 
SOLIDWORKS, the Advanced mode setting is saved. 

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS 
Document dialog box: Templates, MBD, and Tutorial. The Templates tab corresponds to the 
default SOLIDWORKS templates. The MBD tab corresponds to the templates utilized in the 
SOLIDWORKS (Model Based Definition). The Tutorial tab corresponds to the templates 
utilized in the SOLIDWORKS Tutorials. 
 

Advanced mode 

Novice mode 
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Part1 is displayed in the FeatureManager and is the name of the document. Part1 is the default 
part window name.  

The Part Origin  is displayed in blue in the center of the Graphics window. The Origin 
represents the intersection of the three default reference planes: Front Plane, Top Plane and 
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front 
view. The positive Y-axis is vertical and points upward in the Front view. The 
FeatureManager contains a list of features, reference geometry, and settings utilized in the 
part.   

Edit the document units directly from the Graphics window 
as illustrated.  

CommandManager and FeatureManager tabs will vary 
depending on system setup, version, and Add-ins. 
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View the Default Sketch Planes. 

11) Click the Front Plane from the FeatureManager. 

12) Click the Top Plane from the FeatureManager. 

13) Click the Right Plane from the FeatureManager. 

14) Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and 
Right Planes. 

 

Download all model files from the SDC Publication website 
(https://www.sdcpublications.com/downloads/978-1-63057-381-2). Open the Bracket part. 
Review the features and sketches in the Bracket FeatureManager. Work directly from a 
local hard drive.  

Activity: Download the SOLIDWORKS folder. Open the Bracket Part. 

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.  

15) Download the SOLIDWORKS 2021 folder.  

16) Unzip the folder. Work from the unzip folder. 

17) Click Open  from the Menu bar menu. 

18) Browse to the SOLIDWORKS 2021\Bracket folder. 

19) Double-click the Bracket part. The Bracket part is displayed 
in the Graphics window.  
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The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics 
window. The FeatureManager provides a summarized view of the active part, assembly, or 
drawing document. The tree displays the details on how the part, assembly or drawing 
document was created.  

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed 
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree. 
You can add new features or edit existing features while the model is in the rolled-back state. 
You can save models with the rollback bar placed anywhere.  

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.  

Activity: Use the FeatureManager Rollback Bar option. 

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model. 

20) Place the mouse pointer over the rollback bar in the FeatureManager design tree as illustrated. 
The pointer changes to a hand . Note the provided information on the feature. This is called 
Dynamic Reference Visualization.  

21) Drag the rollback bar up the FeatureManager 
design tree until it is above the features you 
want rolled back, in this case 10.0 (10) 
Diameter Hole1.  

22) Release the mouse button.  

Part FeatureManager 
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View the first feature in the Bracket Part. 

23) Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics 
window. 

 

Return to the original Bracket Part 
FeatureManager.  

24) Right-click Extrude-Thin1 in the 
FeatureManager. The Pop-up 
Context toolbar is displayed. 

25) Click Roll to End. View the 
results in the Graphics window.   
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Heads-up View toolbar 

SOLIDWORKS provides the user with 
numerous view options. One of the most 
useful tools is the Heads-up View toolbar displayed in the Graphics window when a document 
is active.   

Dynamic Annotation Views : Only available with SOLIDWORKS MBD (Model 
Based Definition). Provides the ability to control how annotations are displayed when you 
rotate models. 

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate 
and select various view orientations from the Heads-up View toolbar.  

Activity: Utilize the Heads-up View toolbar. 

Zoom to Fit the model in the Graphics window. 

26) Click the Zoom to Fit  icon. The tool fits the model to the 
Graphics window. 

Zoom to Area on the model in the Graphics window. 

27) Click the Zoom to Area  icon. The Zoom to Area  
icon is displayed. 

Zoom in on the top left hole. 

28) Window-select the top left corner as illustrated. View the 
results.  

De-select the Zoom to Area tool. 

29) Click the Zoom to Area  icon. 

Fit the model to the Graphics window. 

30) Press the f key.  

Rotate the model.  

31) Hold the middle mouse 
button down. Drag upward 

, downward , to the 

left  and to the right  to 
rotate the model in the 
Graphics window.  
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Display a few Standard Views.  

32) Click inside the Graphics window.  

33) Click Front  from the drop-down Heads-up 
view toolbar. The model is displayed in the Front 
view. 

34) Click Right  from the drop-down Heads-up 
view toolbar. The model is displayed in the Right 
view. 

35) Click Top  from the drop-down Heads-up 
view toolbar. The model is displayed in the Top 
view. 

Display a Trimetric view of the Bracket model.  

36) Click Trimetric  from the drop-down Heads-
up view toolbar as illustrated. Note your options. 
View the results in the Graphics window. 

SOLIDWORKS Help  

Help in SOLIDWORKS is context-sensitive and in HTML format. Help is accessed in many 

ways, including Help buttons in all dialog boxes and PropertyManager and Help  on the 
Standard toolbar for SOLIDWORKS Help.  

CommandManager and FeatureManagers tabs will vary depending on system setup and 
Add-ins. 
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37) Click  from the Standard toolbar.  

38) Click  Help from the drop-down menu. The 
SOLIDWORKS Home Page is displayed by 
default. View your options. 

SOLIDWORKS Web Help is active by default 
under Help in the Main menu.  

Close Help. Return to the SOLIDWORKS Graphics 
window.  

39) Close  SOLIDWORKS Home.  

SOLIDWORKS Tutorials 
Display and explore the SOLIDWORKS tutorials. 

40) Click  from the Standard toolbar.   

41) Click Tutorials. The SOLIDWORKS Tutorials are 
displayed. The SOLIDWORKS Tutorials are 
presented by category.  

42) Click the Getting Started category. The Getting 
Started category provides lessons on parts, 
assemblies, and drawings. 

In the next section, close all models, tutorials and 
view the additional User Interface tools. 

Activity: Close all Tutorials and Models. 

Close SOLIDWORKS Tutorials and models.  

43) Close  SOLIDWORKS Tutorials. 

44) Click Window, Close All from the Menu bar menu.  

User Interface Tools  
The book utilizes additional areas of the 
SOLIDWORKS User Interface. Explore an overview 
of these tools in the next section.  
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Right-click  

Right-click in the Graphics 
window on a model, or in the 
FeatureManager on a feature or 
sketch to display the Context-
sensitive toolbar. If you are in the 
middle of a command, this toolbar 
displays a list of options 
specifically related to that 
command.  

Right-click an empty space in the 
Graphics window of a part or 
assembly, and a selection context 
toolbar above the shortcut menu is 
displayed. This provides easy 
access to the most commonly used 
selection tools.  

Consolidated toolbar  
Similar commands are grouped together in the 
CommandManager. For example, variations of the Rectangle 
sketch tool are grouped in a single fly-out button as illustrated.  

If you select the Consolidated toolbar button without expanding: 

For some commands such as Sketch, the most commonly used 
command is performed. This command is the first listed and the 
command shown on the button. 

For commands such as rectangle, where you may want to 
repeatedly create the same variant of the rectangle, the last used 
command is performed. This is the highlighted command when 
the Consolidated toolbar is expanded. 

System feedback icon 

SOLIDWORKS provides system feedback by attaching a 
symbol to the mouse pointer cursor.  

The system feedback symbol indicates 
what you are selecting or what the 
system is expecting you to select.  

As you move the mouse pointer across 
your model, system feedback is 
displayed in the form of a symbol, 
riding next to the cursor as illustrated. 
This is a valuable feature in SOLIDWORKS. 
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Confirmation Corner 

When numerous SOLIDWORKS commands are active, a symbol 
or a set of symbols is displayed in the upper right hand corner of the 
Graphics window. This area is called the Confirmation Corner.  

When a sketch is active, the confirmation corner box displays two 
symbols. The first symbol is the sketch tool icon. The second 
symbol is a large red X. These two symbols supply a visual 
reminder that you are in an active sketch. Click the sketch symbol 
icon to exit the sketch and to save any changes that you made.  

When other commands are active, the confirmation corner box 
provides a green check mark and a large red X. Use the green check 
mark to execute the current command. Use the large red X to cancel 
the command.  

Confirm changes you make in sketches and tools by using the D keyboard 
shortcut to move the OK and Cancel buttons to the pointer location in the 
Graphics window.  

Heads-up View toolbar  

SOLIDWORKS provides the user 
with numerous view options from 
the Standard Views, View and 
Heads-up View toolbar.  

The Heads-up View toolbar is a 
transparent toolbar that is displayed 
in the Graphics window when a 
document is active.  

You can hide, move or modify the 
Heads-up View toolbar. To modify 
the Heads-up View toolbar, right-
click on a tool and select or deselect 
the tools that you want to display.  

The following views are available. 
Note: available views are document dependent.  

• Zoom to Fit : Fit the model to the Graphics window. 

• Zoom to Area : Zoom to the areas you select with a bounding box. 

• Previous View : Display the previous view. 

For a drawing document 
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• Section View : Display a cutaway of a 
part or assembly, using one or more 
cross section planes.  

• Dynamic Annotation Views : Only 
available with SOLIDWORKS MBD. 
Control how annotations are displayed 
when you rotate a model. 

The Orientation dialog has an option to 
display a view cube (in-context View 
Selector) with a live model preview. This 
helps the user to understand how each 
standard view orientates the model. With the 
view cube, you can access additional standard views. The 
views are easy to understand and they can be accessed 
simply by selecting a face on the cube. 

To activate the Orientation dialog box, press (Ctrl + 
spacebar) or click the View Orientation  icon from 
the Heads-up View toolbar. The active model is displayed 
in the View Selector in an Isometric orientation (default 
view).  

Click the View Selector icon in the Orientation dialog 
box to show or hide the in-context View Selector.  

Press Ctrl + spacebar to activate the View 
Selector.  

Press the spacebar to activate the Orientation 
dialog box.  

• View Orientation box : Select a view 
orientation or the number of viewports. The 
options are Top, Left, Front, Right, Back, 
Bottom, Single view, Two view - Horizontal, 
Two view - Vertical, Four view. Click the drop-
down arrow to access Axonometric views: 
Isometric, Dimetric and Trimetric.    

• Display Style : Display the style for the 
active view. The options are Wireframe, Hidden 
Lines Visible, Hidden Lines Removed, Shaded, 
Shaded With Edges.  
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• Hide/Show Items : Select items to hide or show in the Graphics 
window. The available items are document dependent. Note the View 
Center of Mass  icon.  

• Edit Appearance : Edit the appearance of entities of the model. 

• Apply Scene : Apply a scene to an active part or assembly 
document. View the available options.  

• View Setting : Select the following settings: RealView Graphics, 
Shadows In Shaded Mode, Ambient Occlusion, Perspective and 
Cartoon.  

• Rotate view : Rotate a drawing view. Input Drawing view angle and 
select the ability to update and rotate center marks with view.  

• 3D Drawing View : Dynamically manipulate the drawing view in 3D 
to make a selection.  

To display a grid for a part, click Options , Document Properties tab. 
Click Grid/Snaps, check the Display grid box. 

Add a custom view to the Heads-up View 
toolbar. Press the space key. The Orientation 
dialog box is displayed. Click the New View  
tool. The Name View dialog box is displayed. 
Enter a new named view. Click OK.  

Use commands to display information about the 
triad or to change the position and orientation of 
the triad. Available commands depend on the triad's 
context.  

Save space in the CommandManager, limit 
your CommandManager tabs. Right-click on a 
CommandManager tab. Click Tabs. View your 
options to display CommandManager tabs. 
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SOLIDWORKS CommandManager 

The SOLIDWORKS CommandManager is a Context-sensitive toolbar. By default, it has 
toolbars embedded in it based on your active document type. When you click a tab below the 
CommandManager, it updates to display that toolbar. For example, if you click the Sketch tab, 
the Sketch toolbar is displayed.  

For commercial users, SOLIDWORKS Model Based Definition (MBD) and 
SOLIDWORKS CAM is a separate application. For education users, SOLIDWORKS MBD 
and SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition. 

Below is an illustrated CommandManager for a Part document. Tabs will vary depending on 
system setup and Add-ins.  

Set button size from the Toolbars tab of the Customize 
dialog box. To facilitate element selection on touch interfaces 
such as tablets, you can set up the larger Size buttons and text 
from the Options menu (Standard toolbar).  
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically 
updates based on the toolbar you want to access. By default, it has toolbars embedded in it 
based on your active document type. The available tools are feature and document dependent.  

Below is an illustrated CommandManager for a Drawing document. Tabs will vary 
depending on system setup and Add-ins.  

 

To add a custom tab, right-click on a tab and 
click Customize. You can also select to add a 
blank tab and populate it with custom tools from 
the Customize dialog box.  
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically 
updates based on the toolbar you want to access. By default, it has toolbars embedded in it 
based on your active document type. The available tools are feature and document dependent.  

Below is an illustrated CommandManager for an Assembly document. Tabs will vary 
depending on system setup and Add-ins.  

The Markup tab is displayed by default in the 
CommandManager on some systems. You can 
draw markups with a mouse on non-touch devices, 
display bounding boxes for markups, create 
markups in drawings, and use the context toolbar to 
access markup options.  
The Markup toolbar displays different options 

depending on the device. Draw  and Touch  
are not available for non-touch devices.  
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Float the CommandManager. Drag the Features, Sketch or any 
CommandManager tab. Drag the CommandManager anywhere on or 
outside the SOLIDWORKS window.   

To dock the CommandManager, perform one of the following:  

While dragging the CommandManager in the SOLIDWORKS 
window, move the pointer over a docking icon - 

, ,  and click the needed 
command. 

Double-click the floating CommandManager to revert the 
CommandManager to the last docking position.  

Collapse the CommandManager  

Collapse the CommandManager to only display the available tabs. 
No tools are shown.  

Click the Collapsed CommandManager arrow to the right of the 
active CommandManager tab as illustrated. Only the tabs are 
displayed. 

Click the Pin CommandManager as illustrated to 
expand the CommandManager and view all tabs and 
tools. Note: This is the default setting. 
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Part FeatureManager Design Tree  

The Part FeatureManager consists of various tabs:  

• FeatureManager design tree  tab. 

• PropertyManager  tab. 

• ConfigurationManager  tab.  

• DimXpertManager  tab. 

• DisplayManager  tab. 

• CAM FeatureManager tree  tab. 

• CAM Operation tree  tab. 

• CAM Tools tree  tab. 

Click the  direction arrows to expand or 
collapse the FeatureManager design tree.  

CommandManager and FeatureManager tabs 
and folder files will vary depending on your 
SOLIDWORKS applications and Add-ins.  

Select the Hide/Show FeatureManager Area tab 

 as illustrated to enlarge the Graphics window 
for modeling.  

The Sensors tool  
located in the FeatureManager 
monitors selected properties in 
a part or assembly and alerts 
you when values deviate from 
the specified limits. There are 
five sensor types: Simulation 
Data, Mass properties, 
Dimensions, Measurement and 
Costing Data.  
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Various commands provide the ability to 
control what is displayed in the 
FeatureManager design tree.   

1. Show or Hide FeatureManager items.  

Click Options  from the Menu 
bar. Click FeatureManager from the 
System Options tab. Customize your 
FeatureManager from the Hide/Show tree 
Items dialog box.  

2. Filter the FeatureManager design tree. 
Enter information in the filter field. You 
can filter by Type of features, Feature 
names, Sketches, Folders, Mates, User-
defined tags and Custom properties.  

Tags are keywords you can add to a SOLIDWORKS 
document to make them easier to filter and to search. The 
Tags  icon is located in the bottom right corner of the 
Graphics window.  

Collapse all items in the FeatureManager, right-click 
and select Collapse items, or press the Shift + C keys.  

The FeatureManager design tree and the Graphics window 
are dynamically linked. Select sketches, features, drawing 
views, and construction geometry in either pane.  

Split the FeatureManager design tree and either display 
two FeatureManager instances, or combine the 
FeatureManager design tree with the 
ConfigurationManager or PropertyManager.  

Move between the FeatureManager design tree, 
PropertyManager, ConfigurationManager, 
DimXpertManager, DisplayManager and others by 
selecting the tab at the top of the menu.  

Split 
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The ConfigurationManager  tab is located to the 
right of the PropertyManager  tab. Use the 
ConfigurationManager to create, select and view 
multiple configurations of parts and assemblies.  

The icons in the ConfigurationManager denote 
whether the configuration was created manually or 
with a design table.  

The DimXpertManager  tab provides the ability to 
insert dimensions and tolerances manually or 
automatically. The options are Auto Dimension 

Scheme , Auto Pair Tolerance , Basic, 
Location Dimension , Basic Size Dimension 

 , General Profile Tolerance , Show 
Tolerance Status , Copy Scheme , Import 

Scheme , TolAnalyst Study  and Datum 
Target .  

TolAnalyst is available in SOLIDWORKS 
Premium.  

Fly-out FeatureManager  

The fly-out FeatureManager design tree provides the 
ability to view and select items in the 
PropertyManager and the FeatureManager design 
tree at the same time.   

Throughout the book, you will select commands and 
command options from the drop-down menu, fly-
out FeatureManager, Context toolbar, or from a 
SOLIDWORKS toolbar.  

Another method for accessing a command is to 
use the accelerator key. Accelerator keys are special 
keystrokes, which activate the drop-down menu 
options. Some commands in the menu bar and items 
in the drop-down menus have an underlined 
character.  
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Task Pane 

The Task Pane is displayed when a SOLIDWORKS session starts. You can show, 
hide, and reorder tabs in the Task Pane. You can also set a tab as the default so it 
appears when you open the Task Pane, pin or unpin to the default location. 

The Task Pane contains the following default tabs:  

• SOLIDWORKS Resources . 

• Design Library . 

• File Explorer . 

• View Palette . 

• Appearances, Scenes and Decals . 

• Custom Properties . 

• SOLIDWORKS Forum . 

• 3DEXPERIENCE Marketplace . 

Additional tabs are displayed with Add-Ins. 
Use the Back and Forward buttons in the Design Library 
tab and the Appearances, Scenes, and Decals tab of the 
Task Pane to navigate in folders. 

SOLIDWORKS Resources 

The basic SOLIDWORKS Resources  menu displays 
the following default selections:  

• Welcome to SOLIDWORKS.  

• SOLIDWORKS Tools. 

• Online Resources. 

• Subscription Services. 

Other user interfaces are available during the initial 
software installation selection: Machine Design, Mold 
Design, Consumer Products Design, etc.  
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Design Library 

The Design Library  contains reusable parts, 
assemblies, and other elements including library 
features.  

The Design Library tab contains default selections. 
Each default selection contains additional sub 
categories.  

The default selections are:  

• Design Library.  

• SOLIDWORKS Content (Internet access 
required).  

• Toolbox.  

Activate the SOLIDWORKS Toolbox. Click 
Tools, Add-Ins.., from the Main menu. Check the 
SOLIDWORKS Toolbox Library and 
SOLIDWORKS Toolbox Utilities box from the 
Add-ins dialog box or click SOLIDWORKS 
Toolbox from the SOLIDWORKS Add-Ins tab.  

To access the Design Library folders in a non-

network environment, click Add File Location  
and browse to the needed path. Paths may vary 
depending on your SOLIDWORKS version and 
window setup. In a network environment, contact 
your IT department for system details.  

File Explorer 

File Explorer  duplicates 
Windows Explorer from your 
local computer and displays:  

• Recent Documents.  

• Samples. 

• Open in SOLIDWORKS. 

• Desktop.   
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Search 

The SOLIDWORKS Search box is displayed in 
the upper right corner of the SOLIDWORKS 
Graphics window (Menu Bar toolbar). Enter the 
text or key words to search.  

New search modes have been added to 
SOLIDWORKS Search as illustrated. 

View Palette 

The View Palette  tool located in the Task Pane 
provides the ability to insert drawing views of an active 
document, or click the Browse button to locate the desired 
document.  

Click and drag the view from the View Palette into an 
active drawing sheet to create a drawing view. 

The selected model is Air Cylinder.  

Appearances, Scenes, and Decals 

Appearances, Scenes, and Decals  provide a simplified 
way to display models in a photo-realistic setting using a 
library of Appearances, Scenes, and Decals.  

An appearance defines the visual properties of a model, 
including color and texture. Appearances do not affect 
physical properties, which are defined by materials. 

Scenes provide a visual backdrop behind a model. In 
SOLIDWORKS they provide reflections on the model. 
PhotoView 360 is an Add-in. Drag and drop a selected 
appearance, scene or decal on a feature, surface, part or 
assembly.  
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Custom Properties 

The Custom Properties  tool provides the ability to 
enter custom and configuration specific properties directly 
into SOLIDWORKS files.  

SOLIDWORKS Forum 

Click the SOLIDWORKS Forum  icon to search 
directly within the Task Pane. An internet connection is 
required. You are required to register and to log in for 
postings and discussions.  

3DEXPERIENCE MARKETPLACE 

Click the 3DEXPERIENCE MARKETPLACE  icon to 
connect to the 3DEXPERIENCE platform and leverage its 
collaboration, product data and lifecycle management, 
organic shape design, simulation solutions, and more. 
(Subscription required.) 

Motion Study tab 

Motion Studies are graphical simulations of motion for an 
assembly. Access the MotionManager from the Motion 
Study tab. The Motion Study tab is located in the bottom left 
corner of the Graphics window.  

Incorporate visual properties such as lighting and camera 
perspective. Click the Motion Study tab to view the 
MotionManager. Click the Model tab to return to the 
FeatureManager design tree.  
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The MotionManager displays a timeline-based 
interface and provides the following selections from the 
drop-down menu as illustrated: 

• Animation: Apply Animation to animate the 
motion of an assembly. Add a motor and insert 
positions of assembly components at various times 
using set key points. Use the Animation option to 
create animations for motion that do not require 
accounting for mass or gravity. 

• Basic Motion: Apply Basic Motion for 
approximating the effects of 
motors, springs, collisions and 
gravity on assemblies. Basic 
Motion takes mass into account in 
calculating motion. Basic Motion 
computation is relatively fast, so 
you can use this for creating 
presentation animations using 
physics-based simulations. Use the 
Basic Motion option to create 
simulations of motion that account 
for mass, collisions or gravity.  

If the Motion Study tab is not 
displayed in the Graphics window, 
click View  Toolbars  
MotionManager from the Menu bar.  



Overview of SOLIDWORKS® and the User Interface         SOLIDWORKS® 2021 Quick Start 

 PAGE 1 - 34  

3D Views tab 

SOLIDWORKS MBD (Model Based 
Definition) lets you create models without the 
need for drawings giving you an integrated 
manufacturing solution. MBD helps companies 
define, organize, and publish 3D product and 
manufacturing information (PMI), including 
3D model data in industry standard file 
formats.  

Create 3D drawing views of your parts and 
assemblies that contain the model settings 
needed for review and manufacturing. This lets 
users navigate back to those settings as they 
evaluate the design.  

Use the tools in the MBD Dimensions CommandManager to set up your model with selected 
configurations, including explodes and abbreviated views, annotations, display states, zoom 
level, view orientation and section views. Capture those settings so that you and other users 
can return to them at any time using the 3D view palette. 

To access the 3D View palette, click the 3D Views tab at the bottom of the SOLIDWORKS 
window or the SOLIDWORKS MBD tab in the CommandManager. The Capture 3D View 
button opens the Capture 3D View PropertyManager, where you specify the 3D view name, 
and the configuration, display state and annotation view to capture. See SOLIDWORKS help 
for additional information. 

Dynamic Reference Visualization 
(Parent/Child)  

Dynamic Reference Visualization provides the ability 
to view the parent/child relationships between items in 
the FeatureManager design tree. When you hover over 
a feature with references in the FeatureManager design 
tree, arrows display showing the relationships. If a 
reference cannot be shown because a feature is not 
expanded, the arrow points to the feature that contains 
the reference and the actual reference appears in a text 
box to the right of the arrow.  
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Use Dynamic reference visualization for a part, 
assembly and mates.  

To display the Dynamic Reference Visualization, 
click View  User Interface  Dynamic 
Reference Visualization Parent/Child) from the 
Main menu bar.  

Mouse Movements 

A mouse typically has two buttons: a primary 
button (usually the left button) and a secondary 
button (usually the right button). Most mice also 
include a scroll wheel between the 
buttons to help you scroll through 
documents and to Zoom in, Zoom out 
and rotate models in SOLIDWORKS. 
It is highly recommended that you use a 
mouse with at least a Primary, Scroll 
and Secondary button.  

Single-click 

To click an item, point to the item on 
the screen, and then press and release the primary button (usually the left button). Clicking is 
most often used to select (mark) an item or open a menu. This is sometimes called single-
clicking or left-clicking. 

Double-click 

To double-click an item, point to the item on the screen, and then click twice quickly. If the 
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather 
than as one double-click. Double-clicking is most often used to open items on your desktop. 
For example, you can start a program or open a folder by double-clicking its icon on the 
desktop. 

Right-click 

To right-click an item, point to the item on the screen, and then press and release the 
secondary button (usually the right button). Right-clicking an item usually displays a list of 
things you can do with the item. Right-click in the open Graphics window or on a command in 
SOLIDWORKS, and additional pop-up context is displayed.  

Scroll wheel 

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS. 
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward 
(away from you).  



Overview of SOLIDWORKS® and the User Interface         SOLIDWORKS® 2021 Quick Start 

 PAGE 1 - 36  

Summary 

The SOLIDWORKS (UI) is designed to make maximum use of the Graphics window for 
your model. Displayed toolbars and commands are kept to a minimum. 

The SOLIDWORKS User Interface and CommandManager consist of the following main 
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars, 
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up 
View toolbar. 

The Part CommandManager controls the display 
of tabs: Features, Sketch, Markup, Evaluate, 
MBD Dimensions and various SOLIDWORKS 
Add-Ins.    

The FeatureManager consists of various tabs:  

• FeatureManager design tree  tab. 

• PropertyManager  tab. 

• ConfigurationManager  tab.  

• DimXpertManager  tab. 

• DisplayManager  tab. 

• CAM FeatureManager tree  tab. 

• CAM Operation tree  tab. 

• CAM Tools tree  tab. 

Click the  direction arrows to expand or 
collapse the FeatureManager design tree. 

CommandManager and FeatureManager tabs and 
file folders will vary depending on system setup 
and Add-ins. 

You learned about creating a new SOLIDWORKS part and opening 
an existing SOLIDWORKS part along with using the Rollback bar 
to view the sketches and features.  

If you modify a document property from an Overall drafting 
standard, a modify message is displayed as illustrated.  
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Use the Search box, in the upper left corner of the Materials 
dialog box, to search through the entire materials library.  

Templates are part, drawing and assembly documents which 
include user-defined parameters. Open a new part, drawing or 
assembly. Select a template for the new document.  
In Chapter 2, establish a SOLIDWORKS session. Learn about 
2D Sketching and 3D features.  

Create a new part. Create the Wheel for the Fly Wheel sub-
assembly.  

Utilize the Fly Wheel sub-assembly in the final Stirling 
Engine assembly.  

Apply the following sketch and feature tools: Circle, Line 
Centerline, Centerpoint Straight Slot, Mirror Entities, 
Extruded Boss, Extruded Cut, Revolved Boss, Circular 
Pattern, Hole Wizard and Fillet.  

Incorporate design change into a part using proper design 
intent, along with applying multiple geometric relations: 
Coincident, Vertical, Horizontal, Tangent and Midpoint 
and feature and sketch modifications.  

Utilize the Material, Mass Properties and Appearance 
tool on the Wheel. 
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Notes:  
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